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Welcome to BrightLink! 
This kit has everything you need to get started with BrightLink. Here’s how:

  1 First, follow the steps on the Start Here card to 
get up and running.

  2 Install the manuals from the BrightLink 475Wi/
480i/485Wi CD in this kit.

BrightLink Training Resources

3 Then click the BrightLink Training Resources
link on your desktop to get a DVD containing 
BrightLink training videos. 

   4 Play with the software. Tip sheets for 
TeamBoard Draw and Easy Interactive Tools are 
right in this kit.

For help, software, manuals, FAQs, and more, go to epson.com/brightlinkdownloads (U.S.) 
or epson.ca/brightlinkdownloads (Canada).



EPSON iProjection™ for iPad®,
iPhone®, and iPod® touch 
The EPSON iProjection app lets you show documents and photos wirelessly from Apple®

devices on your BrightLink! If the projector is on a network that includes a wireless access 
point (or you have the optional wireless module), the app will work for you.

You can download EPSON iProjection for free from the App Store. For more information, 
visit: www.epson.com/projectorapp (U.S.) or  www.epson.ca/projectorapp (Canada).

Still need help?
The PrivateLine® service is for you! All you have to do is call (800) 637-7661. This service is 
available for the duration of your warranty period. 

You may also speak with a projector support specialist by dialing (562) 276-4394 (U.S.) or 
(905) 709-3839 (Canada).

Support hours are 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 4 PM,
Pacific Time, Saturday. 

Days and hours of support are subject to change without notice. Toll or long distance 
charges may apply.



Getting up and running with 
BrightLink is easy! 
Learning BrightLink basics takes less than 30 minutes. The resources in this kit will help you 
take your first steps toward a more interactive classroom.

The BrightLink online support center provides lots of additional resources. Click the 
BrightLink Training Resources link on your desktop or go to epson.com/brightlink 
(U.S.) or epson.ca/brightlink (Canada). Training options include:

• Free webinars will help you use BrightLink’s interactivity to engage students and 
enhance your instruction.

• Short tutorials can help you master a new tool or application of your BrightLink in mere 
minutes. Watch, listen, and follow along.

• Onsite professional development provides more specific and personalized training for 
your school.

With the help of these tools and resources, you can start using your BrightLink in powerful 
ways from the very first day you turn it on! 
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BrightLink Interaction
The BrightLink interactive pens turn any wall or table into 
an interactive area, either with or without a computer.

• With a computer, you can use Easy            
Interactive Tools (dual pens). This 
software lets you use the pen as a mouse 
to annotate, save, and interact with 
content from your computer.

• Without a computer, you can use the      
toolbar that is built into the projector 
(single pen). This lets you annotate 
images from a document camera, 
tablet, DVD player, or other source 
connected to your projector.

Students and colleagues can connect 
their own laptops and annotate on the 
fly using the built-in toolbar, without 
installing software.

Get a DVD containing BrightLink 
training videos! 

Just click the BrightLink Training 
Resources link on your desktop or go 
to www.epson.com/eduresources
and request a DVD.

Start Here
Follow the steps on this card to get started with your 
BrightLink:

1 Connect your computer and turn on the projector

2 Make sure the software is installed 

3 Calibrate

• Using the remote control

4 Use the pens

• Choosing the right tool

5 Use the built-in toolbar



6	 �Select Use Source and press Enter.

 

7	 �Select the source where your computer is 
connected. For example, if your computer is 
connected with a VGA cable to the projector’s 
Computer1 port, select Computer1. If your 
computer is connected with an HDMI cable, select 
HDMI.

	 �If you don’t know which source to select, check 
with your school’s tech coordinator.

8	 �Display an image from your computer. If the image 
doesn’t appear, try one of the following:

	 •	 �On some Windows laptops, you may need to 
hold down the Fn key on the keyboard and press 
F7 or the function key that lets you display on 
an external monitor. It may have an icon such as 

, or it may be labelled CRT/LCD. 

	 •	 �On a Mac®, you may need to open System 
Preferences and select Displays. Select the 
VGA Display or Color LCD option if necessary, 
then click the Arrange or Arrangement tab, 
and select the Mirror Displays check box.

	 •	 �Try pressing the Source Search button on the 
remote control.

1	  �Connect Your Computer and 
Turn on the Projector

1	  �Connect the USB cable directly to any available 
USB port on your computer.

USB cable

2	 �Connect an HDMI or VGA cable from the projector 
to your computer.

HDMI

VGA

3	  �Turn on the projector by pressing the red  power 
button on the remote control.

	  �In Windows®, you may see messages about device 
drivers or new hardware.

	  �Depending on how your computer is connected to 
the projector, you may need to select your source 
for computer interaction.

4	 �Press the Menu button on the remote control, select 
the Extended menu, and press Enter.

5	 �Select the Easy Interactive Function setting and 
press Enter.



If you need to install the software

Do one of the following:

• Use the CD that came with the projector, labeled 
“EPSON Projector Software for Easy Interactive 
Function”

• Download the most up-to-date version from:
epson.com/brightlinkdownloads (U.S.)
epson.ca/brightlinkdownloads (Canada)

For more information about Easy Interactive Tools, see 
the Easy Interactive Tools Tips sheet in this Welcome 
Kit or the BrightLink User’s Guide.

You can also install TeamBoard Draw, an intermediate 
level annotation program, from the CD that came with the 
projector. 

For more information, see the TeamBoard Draw Tips 
sheet in this Welcome Kit or the TeamBoard videos at 
epson.com/brightlink (U.S.) or epson.ca/brightlink
(Canada).

2 Make Sure the Software Is Installed 

You may already have the software on your computer, or 
you may need to install it yourself. For Mac OS® X, you 
need Easy Interactive Driver and Easy Interactive Tools. 
For Windows, you only need Easy Interactive Tools.

Here’s how to find out if the software is installed on your 
computer:

If you are using a Mac:
Look for the Easy Interactive Driver and Easy Interactive 
Tools folders in the Application folder on your hard drive. 
If you see these folders, the software is installed.

If you are using Windows:
Select  or Start > All Programs or Programs > 
EPSON Projector > Easy Interactive Tools Ver. 2.00. If 
you see Easy Interactive Tools Ver. 2.00, the software is 
installed.

If the software is not installed, follow the steps in the next 
column to install it.



3	  Calibrate

Calibration coordinates the position of the pen with the 
location of your cursor. If the pen position and cursor 
location don’t match, you can try auto calibration, or you 
can calibrate manually for even greater accuracy. You 
don’t need a computer, and you won’t need to calibrate 
again unless the projector or image is moved, or the 
image is resized.

1	  �To start calibration, press the User button on the 
remote control.

2	 �When you see the Auto Calibration screen, do one 
of the following:

	 • �Press Enter to try auto calibration, then wait until 
calibration is complete.

	 • �Select No, then press Enter and follow the steps 
below to calibrate manually.

3	� When you see this screen, select Manual 
Calibration.

4	 �When you see this screen, press Enter to select 
Yes.

5	 �Follow the instructions on the screen to touch the 
circles and perform manual calibration.

For more detailed instructions, see the on-screen 
BrightLink User’s Guide.

Using the Remote 
Control

Select from various 
image sources 
connected to the 
projector

Enter

Zoom in and out

Stop video action

Turn projector 
on/off

Access menu 
system for 
additional 

adjustments

Calibrate

Page through 
documents 

Temporarily  
turn off image

For more information on using the remote control and 
cool time-saving buttons:

•	 �See the BrightLink User’s Guide on your computer or 
on the CD in this Welcome Kit.

•	 �Go to the training section and watch a video or two at 
epson.com/brightlink (U.S.) or epson.ca/brightlink 
(Canada) or atomiclearning.com.



Choosing the Right Tool
If you already have annotation software, you can use 
it with BrightLink. If you are using Microsoft® Office 
2003 or later, you can also use the “inking tools” to add 
handwritten notes to your documents and PowerPoint® 
presentations. 

Here are some tips on choosing among the tools that 
came with your BrightLink projector:
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Annotate on computer display • • •

Annotate on white 
background

• • •

Annotate on images from 
document cameras or other 
sources

•

Use both pens simultaneously •

Save annotations • •

Record lessons and import/
export files

•

Your projector came with 2 pens that have different 
colored ends, orange and blue. Make sure one AA 
battery is installed in each pen.

Battery light

Power switch

•	 �To turn on the pen, slide the power switch. The green 
light comes on briefly. If the battery is low, the light 
flashes. 

•	 �Hold the pen perpendicular to the board, as shown 
below.

•	 �To left-click, tap on the board.

•	 �To double-click, tap twice.

•	 �To right-click, press the board with the pen for about 
3 seconds.

•	 �To click and drag, tap and drag with the pen.

•	 �To move the cursor, hover over the board without 
touching it.

•	 �When you are finished, slide the power switch to turn 
off the pen.

Note: The pens turn off automatically after about 20 
minutes of inactivity. Slide the switch to turn the pen 
back on. Ready to Learn More?

4	 Use the Pens  
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Two different toolbars are available, one for annotation 
mode and one for whiteboard mode.

• Annotation mode displays the built-in toolbar on 
whatever image is being projected.

• Whiteboard mode lets you project a white or black 
screen or background pattern, and use the pen to write 
or draw as you would on a chalkboard or dry erase 
board.

Select whiteboard 
mode

Redo 

Zoom into image

Use custom pen 

Use hightlighter 

Use black, red, or blue 
pen—select large dot 
for thick line 

Erase—select large dot 
for thick eraser

Clear all annotations

Close toolbar

Select annotation 
mode

Undo

Select background 
color or pattern*

Recalibrate 

Change custom pen 
color and width

Change highlighter 
color 

Use black, red, or 
blue pen—select 

small dot for thin line

Erase—select small 
dot for thin eraser

Hide toolbar after 
each annotation

 * In annotation mode, the freeze tool appears instead of this one. It 
lets you stop or resume action in a video.

Ready to Learn More?

• Sign up for complimentary webinars

• Watch helpful how-to videos

• Find out about cool, free interactive sites

Click the BrightLink Training Resources 
link on your desktop or go to 
www.epson.com/eduresources.

5 Use the Built-In Toolbar  

The projector’s built-in toolbar lets you annotate images 
from other devices that have been connected to the 
projector, such as a document camera, tablet, or other 
source. You can write with only one pen at a time, but 
you can use both pens and trade off.

1 Press one of the Source buttons on the remote 
control to select the source for the image you want 
to annotate. (Make sure you do not select the same 
source that is selected for Easy Interactive Function 
in the Extended menu.)

Image from an 
external device 
connected to the 
USB port

Image from a 
computer connected 

to the Computer2
port

Image from a computer with 
an HDMI connection, or a 

video player

Image from a computer or 
iPad connected through a 
wired or wireless network

2 To activate the toolbar, tap the board with the pen. 
You see arrow icons on the left and right side of 
the projected image.

Note: The toolbar arrows disappear if they are not 
used. To make them reappear, tap the board with 
the pen.

3 To display the toolbar, select one of the arrows.

4 To close the toolbar, select the icon at the 
bottom of the toolbar.

Note: Many of the built-in tools are the same as Easy 
Interactive Tools, but fewer functions are available. 
All of the tools are available, even if they have a gray 
background.



Easy Interactive Tool Tips

1	 To start Easy Interactive Tools on your computer, do one of the following:

	 �•	 ��Windows ®: Select  or Start > All Programs or Programs > EPSON Projector > Easy Interactive Tools.

		  ��Or, double-click the  Easy Interactive Tools icon on your desktop.

	 �•	 ��Mac OS X ®: Select Applications > Easy Interactive Tools > Easy Interactive Tools.

	 �The Easy Interactive toolbar appears on the projected image, and an  arrow appears on the other side of the 
image. Two different toolbars are available, one for interactive mode and one for whiteboard mode:

Interactive Mode
In interactive mode, the toolbar 
appears on the projected 
image and lets you use the 
pen as a mouse to open 
applications, access links, 
and operate scroll bars, for 
example. 

In this mode, you can also 
annotate whatever is displayed 
from your computer or 
document camera and save or 
print your pages.

Interactive
tools

Annotation
tools

Whiteboard
tools

Annotation
tools

Interactive toolbar    Whiteboard toolbar

Whiteboard Mode
In whiteboard mode, the toolbar 
appears on a blank surface, 
background image, or pattern. 
You can write or draw with the 
pen, add images, and save or 
print your pages. 

Annotating 

You can use the annotation tools 
at the bottom of the toolbar in 
either mode.

2	 �To toggle between modes, select the  Annotation mode icon to display the interactive toolbar, or the  
Whiteboard mode icon to display the whiteboard toolbar.

3	 �To exit Easy Interactive Tools, select the  Exit icon in the lower right corner of the toolbar. You can also minimize the 
toolbar by selecting the  Close icon, then select the  arrow to redisplay the toolbar.

Tools for Interactive Mode

Switch to whiteboard mode

Save the current screen 

Page up/down in a browser or other program

Use an on-screen keyboard to enter text in a browser or  
other program 

Insert a circle, square, triangle, or other shape

Switch to interactive mode

Toggle between pen and mouse modes 

Undo/redo multiple operations (one at a time)

Display the image from a document camera
connected to the computer via USB

Use the magnifier to enlarge the image

Display additional tools for saving, printing, and more



Tools for Annotation

Hide/minimize the toolbar

Write or draw with custom pen

Write or draw with transparent highlighter pen

Use black, red, or blue pen—select large dot for thick lines

Erase—select large dot for thick eraser

Exit Easy Interactive Tools

Change custom pen color and width

Change highlighter pen color and width

Use black, red, or blue pen—select small dot for thin lines

Erase—select small dot for thin eraser

Clear all annotations

Toggle between hiding the toolbar after use and  
showing it continuously

Tools for Whiteboard Mode

Switch to whiteboard mode

Save the current screen

Undo/redo multiple operations (one at a time)

Open a new page

Delete the current page 

Display a cursor that lets you resize or move an  
inserted image 

Insert a circle, square, triangle, or other shape

Switch to interactive mode

Select from background patterns or colors, or display an 
image from a document camera

Display a list of pages currently being edited

Insert an image from a file or from a document camera 
connected to the computer

Use the magnifier to enlarge the image

Display additional tools for saving, printing, and more

Tools for Saving, Printing, and More

To display the tools shown below, select the  Other tools icon on the toolbar.

Cover the image with a movable shade

Open the settings screen, which lets you select settings for 
saving your pages and more

Display help (interactive mouse mode only)

Display a movable spotlight effect.

Print the currently displayed image. In whiteboard mode, you can 
select the pages to print.

Change the next pen tap to a right click (interactive mouse  
mode only)

1	 �To save your screen or pages as .jpg files in your Documents > Easy 	 	
Interactive Tools folder, simply select the  Save tool. Easy Interactive 
Tools names your file automatically based on the date and time.

2	 �To select other locations and formats for saving, select the  Settings 
tool, then select the Save settings tab, as shown on the right.

3	 �Select the location, file name, and file type for saving pages. You can save 
all your pages as one PDF file.

4	 �If you want to select different settings each time you save, select the Check 
when saving checkbox.

5	 �Select OK to close the Settings window.
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TeamBoard Draw Tips  

1	 To start TeamBoard, do one of the following:

	 �•	 ��Windows ®: Select  or Start > All Programs or Programs > Teamboard > Draw.

		  ��Or, right-click the  TeamBoard Draw icon in your system tray (lower right corner of your 
screen) and select TeamBoard Draw. 

	 �•	 ��Mac OS X ®: Open the Applications folder and select  Draw. 

Standard toolbar

Main toolbar

Pen Shapes Text Clipboard

Eraser Creative
pen

Move

Main tools

Submenu

Add clip art

Record View tutorials Hide/reveal

Spotlight

Page sorter

Action toolbar 
(Select View > 

Toolbars >  
Action Bar) Small eraser

Large eraser

Colored pens

Insert page

Copy page

Print page

Navigation tools

	 The Main toolbar has 7 key tools. Each tool has its own submenu on the right side (after the  red arrow).

2	 Move your mouse or interactive pen over any of the tool icons to see a definition.

Select word

Pen tools

Eraser tools

Shape tools

Move toolsClipboard tools

Text tools

Creative pen tools

Word bank

Speak word

Speak sentence
Move object

Link object

Color fillMulti-copy

Copy

Multi-cut

Cut

Paste

TeamBoard training videos and webinars are available at www.epson.com/brightlink (U.S.) or  
www.epson.ca/brightlink (Canada). Select BrightLink for Education, then Training.



�Using the Annotation 
Toolbar 

Collapse toolbar

Full-screen 
annotate

Select Freehand 
or Rectangle to 
capture screen

Open full 
TeamBoard 
Draw screen

Use virtual keyboard

Open 
application 

list

1	 �To access the floating annotation toolbar or 
dashboard, do one of the following:

	 •	 �Windows: Select  or Start > All 
Programs or Programs > Teamboard > 
Annotation.

		  ��Or, right-click the  TeamBoard Draw 
icon in your system tray (lower-right corner 
of your screen) and select Annotation. 

	 •	 �Mac OS X: Select the   
TeamboardAnnotate icon on your screen.

2	� To take a full-screen snapshot for annotation, 
select the  camera icon. The following 
toolbar appears:

	 �You can use all of the TeamBoard tools to draw 
or annotate on a web page or anything else on 
your computer.

3	� To save your annotations and return to your 
desktop, select the  icon on the right end of 
the toolbar.

4	� To save annotated images in TeamBoard, open 
the File menu and select one of the following:

	 •	 �Save as (to save in .tmb file format)

	 •	 �Export (to save in .jpg, .ppt, .bmp, .pdf, 
.html, .tif, .png, or .iwb file formats)

	 �After you export a .ppt file, you can open it 
in PowerPoint®. First you need to associate 
PowerPoint with TeamBoard by following the 
steps in the next column.
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�Presenting and 
Annotating in PowerPoint 
First, you need to associate PowerPoint with TeamBoard.

1	 �Open the Tools menu and select Options. 

2	 �Select the Application Control tab, then select 
the Add button.

3	 �Locate and select POWERPNT.EXE in your 
Program Files\Microsoft Office folder. 

4	 �Select OK, then select OK again to close the 
Options window.

Once you have associated PowerPoint, you can open it 
from the TeamBoard annotation toolbar:

Additional tools appear on the toolbar as shown below:

Start/stop 
presentation

Pens Erasers
In-show slide 
management

Arrow 	
tool

Black 
screen

You can open your PowerPoint file and annotate it using 
the TeamBoard tools. When you are finished, select Keep 
to save your “ink annotations” with the PowerPoint file. 
This is great for sharing meeting notes.
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